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Information About the Excel Spreadsheet Solutions
The Excel Spreadsheet Solutions have been licensed to Microsoft by Village Software, Inc.    Village Software® 
provides a variety of business and financial desktop solutions for Excel and Office.    Our solutions, many of 
which are upgrades to the Spreadsheet Solution templates, all carry the Microsoft Office-Compatible logo.    For a
free catalog, call 800-724-9332 or come to our Web site. (http://www.villagesoft.com)

Note that no free telephone support is offered for these online templates.    A support package is available at a 
nominal charge from Village Software.    Call 800-724-9332 to purchase this plan and/or template upgrades.

These online templates are copyrighted, licensed software, intended to be used as-is.    They may NOT be 
placed in shareware libraries or embedded in commercial applications without the written consent of Village 
Software, Inc.



Customizing a template
Before using a template to create a document, fill in the Customize sheet with information about your company, 
family finances, and other information you want to appear on each new timecard, budget, or other document. 
When you create a new document based on your customized template, the "standard" information is entered for 
you.

To customize the standard information in a template
1    On the File menu, choose New and select the template you wish to use.    In Microsoft Excel version 7.0 or 
later, click the Spreadsheet Solutions tab to see the available templates.

2    Click the Customize button in the upper-right corner, and then fill in the indicated information on the 
Customize sheet.

3    You can include a logo and change the font of your company information. If you don't insert a logo, the 
placeholder won't show up when you print the document. This function is not available on the Macintosh.

4    After filling in the information, click the Lock/Save Sheet button, and then click Lock And Save Template under
Locking Options.    The Lock and Save Template function is not available on all platforms.    If this option is not 
available, users should instead choose Save As… from the File menu.

5    In the Save Template dialog box, type a name for your customized template in the File Name box, and then 
click Save.    Macintosh users should select 'Template' in the Save File as Type dropdown box before saving, and
should save the file to System:Preferences:Excel Startup Folder (5).    If the Excel Startup Folder (5) folder does 
not exist, it should be added to the Preferences folder.

6    On the File menu, click Close.

To use the customized template to create a new document
1    On the File menu, click New, and then click the template you want to use.

2    Fill in the indicated information.

3    Save the new document as a Microsoft Excel workbook file.

4    To print the document, click the Print button on the Standard toolbar.

5    The correct print range for each sheet is automatically specified.

Protecting the customized template to simplify data entry
You may lock worksheets in your customized template to simplify data entry.    Note that some functions (like 
sample data) will no longer function once worksheets are locked.    Additionally, certain consolidation functions 
will not operate when worksheets are locked.    As a result, it is recommended that you do not lock the Timecard 
or Loan Manager templates.    In order to lock the worksheets in your customized template:

1    Activate the particular sheet you wish to lock

2    From the Tools menu, select Protection|Protect Sheet…

3    Type in a password (optional), and then click OK.

Follow these steps for each sheet in the workbook which you want to lock.



Template Toolbar Help
Size to Screen/Return to Size      Displays the entire form at a reduced size or restores the template to its full 
size.
Hide CellTips/Display CellTips      Switches Cell Note display off or on. With Cell Notes displayed, a small red 
dot in the upper-right corner of a cell indicates that the cell has a Cell Note to help you fill in the cell. Click in a 
cell and choose Insert|Note to display its Cell Note. If you don't see any red dots, make sure that this button is 
not "pushed in."
Document A Cell      Adds your own Cell Note to a cell in the template.
Template Help      Displays a Help topic for the current template.
Display Example/Remove Example      Fills in cells with an example showing how to use the sheet. Click the 
button again to remove the example.
Split and Freeze Panes      Splits the screen horizontally and freezes the top pane so that information (such as 
column headings) remains visible when you scroll through the lower pane. Click in the template below where you
want to split the screen, and then click the Split And Freeze Panes button. To remove the split, click the button 
again. This button is available only in templates in which you fill in information in columns.
Bring Up A Calculator      Displays a calculator.
About Village Software      Displays information about Village Software.



Timecard
This template is licensed to Microsoft by Village Software®. To learn more about Village Software, click the About
Village Software button on the Timecard toolbar.

The Timecard tracks the time you spend working on various accounts and projects during a given period.

Before using the template, fill in the Customize sheet with your company's information and payroll requirements, 
such as whether or not overtime requires approval. For information about customizing the template, see 
Customizing a template.

To fill out a time card
1    Fill in the employee information.

2    Fill in the hours worked each day for each account or project.    Hours are automatically totaled and 
summarized on the Timecard Summary Sheet.

For detailed help on filling in a time card, refer to the Cell Notes provided in the template. For information about 
the buttons on the Timecard toolbar, see Template Toolbar Help.



Business Planner
This template is licensed to Microsoft by Village Software®. To learn more about Village Software, click the About
Village Software button on the Planner toolbar.

The Business Planner analyzes your current financial status and forecasts your future cash flow.

Before using the template, fill in the Customize sheet with your company's information and indicate whether your 
company is a C-Corporation or an S-Corporation. Corporate income taxes are computed for a C-Corporation but 
not for an S-Corporation. If your company is a partnership or sole proprietorship, select S-Corporation so that 
corporate income taxes are not computed. For information about customizing the template, see Customizing a 
template.

Important      This product includes sample forms only. Using these forms may have significant legal implications;
these vary from state to state and depend on the subject matter. Use of these forms may not necessarily comply 
with generally accepted accounting principles (GAAP) or other accounting principles or standards. Before using 
any of these forms for your business, you should consult with a lawyer, a financial advisor, and/or an accountant. 
Microsoft and its suppliers are not responsible for any action you take based on the use of this template.

To use the Business Planner
1    On the Data sheet, enter the number of days applicable to each operating category at the end of each period, 
the estimated expense data percentages for each category, and the financing data.

To see how changes in the data affect your financial statements, click the How Will Turnover Affect My Financials
button on the Data Chart sheet. You can manipulate the chart and see how this affects the corresponding data on
the Data sheet.

2    On the Income Statement sheet, enter the following:

Total sales revenue forecast for each quarter

Cost estimates for the following categories:

        Amortization
        Gain/Loss on Asset Sales
        Other Gains/Losses
        Income Tax
        Dividends Paid
        Cost of Sales
        Other Costs

Detailed data for inventory (cost of sales) and supporting information, including figures for depreciation of and 
interest on buildings and equipment.

3    On the Balance sheet, enter the forecast data for each quarter. Include beginning asset and liability data and 
any data for the following special asset categories:

Current Assets
Fixed Assets
Intangible Assets
Other Assets
Current Liabilities
Non-Current Liabilities
Stockholder's Equity

4    Enter the actual data for these same categories. 

Note      Enter the data sequentially from top to bottom. Incorrect figures will result in errors in your cash flow 
calculations.

5    To check your cash balance, scroll to the bottom of the Balance sheet. 

If the cash balance is negative, you may need to increase debt or make some other type of adjustment that will 
create a positive cash balance.

If the cash balance is excessive, you may want to reduce the debt or record additional interest income.

For detailed help in filling in the information, refer to the Cell Notes provided in the template. For information 



about the buttons on the Planner toolbar, see Template Toolbar Help.



Personal Budgeter
This template is licensed to Microsoft by Village Software®. To learn more about Village Software, click the About
Village Software button on the Budgeter toolbar.

The Budgeter template provides an easy way to organize your personal finances.

Before using this template, fill in the Customize sheet with your family information. Then gather your income 
information (including weekly pay and withholding information) and all monthly bills for the past several months. 
For information about customizing the template, see Customizing a template.

Important      This product includes sample forms only. Using them may have significant legal implications; these 
vary from state to state and depend on the subject matter. Use of these forms may not necessarily comply with 
generally accepted accounting principles (GAAP) or other accounting principles or standards. Before using any 
of these forms for your business, you should consult with a lawyer, a financial advisor, and/or an accountant. 
Microsoft and its suppliers are not responsible for any action you take based on the use of this template.

To create a budget
1    On the Income Data sheet, enter your personal income information.

2    On each of the expense data sheets (Utilities, Insurance, Living Expenses, Entertainment, and Credit Cards), 
enter your expenses and your contingency amounts, or "safety margins."

3    On the Budget Summary sheet, check whether your income covers your expenses. If not, you should find a 
way to lower some of your expenses.

For detailed help on entering income and expense data, refer to the Cell Notes provided in the template. For 
information about the buttons on the Budgeter toolbar, see Template Toolbar Help.



Sales Quote
This template is licensed to Microsoft by Village Software®. To learn more about Village Software, click the About
Village Software button on the Sales Quote toolbar.

The Sales Quote template provides an easy way to prepare and track sales quotes for customers and other 
clients.

Before using this template, fill in the Customize sheet with your company's information and any information you 
want to appear on each sales quote, such as applicable taxes and discounts. For information about customizing 
the template, see Customizing a template.

To create a sales quote
1    Fill in the requested information.

For detailed help on filling in a sales quote, refer to the Cell Notes provided in the template. For information about
the buttons on the Sales Quote toolbar, see Template Toolbar Help.



Loan Manager
This template is licensed to Microsoft by Village Software®. To learn more about Village Software, click the About
Village Software button on the Loan toolbar.

The Loan Manager amortizes loans such as automobile loans, allowing you to view different loan scenarios.

Before using the template, fill in the Customize sheet with your family information. For information about 
customizing the template, see Customizing a template.

Important      This product includes sample forms only. Using them may have significant legal implications; these 
vary from state to state and depend on the subject matter. Use of these forms may not necessarily comply with 
generally accepted accounting principles (GAAP) or other accounting principles or standards. Before using any 
of these forms for your business, you should consult with a lawyer, a financial advisor, and/or an accountant. 
Microsoft and its suppliers are not responsible for any action you take based on the use of this template.

To compare loan options
1    On the Loan Data sheet, fill in the indicated information in the cells.

2    The Loan Amortization Table sheet shows the schedule for repayment of your loan, including the interest and 
balance. If you make more than your scheduled payments, enter the additional principal you've paid in the last 
column of this table.

The Summary Graph sheet displays principal and interest information presented for the life of your loan. To 
change the chart format series, click the Change Graph button.

For detailed help on filling in your loan information, refer to the Cell Notes provided in the template. For 
information about the buttons on the Loan toolbar, see Template Toolbar Help.



Change Request
This template is licensed to Microsoft by Village Software®. To learn more about Village Software, click the About
Village Software button on the CR Tracker toolbar.

The Change Request allows you to track problems with a product or process.

Before using this template, fill in the Customize sheet with the sheet fields and titles that are pertinent to your 
particular product or process. You can change the available list items for the Status, Priority, and Severity boxes. 
Change the name of the change request form in the Main Title section. For information about customizing the 
template, see Customizing a template.

To create a change request
1    Fill in the indicated information.

For detailed help on filling in a change request, refer to the Cell Notes provided in the template. For information 
about the buttons on the CR Tracker toolbar, see Template Toolbar Help.



Car Lease Manager
This template is licensed to Microsoft by Village Software®. To learn more about Village Software, click the About
Village Software button on the Car Lease toolbar.

The Car Lease Manager helps you determine your best options when you lease a vehicle.

Before using this template, fill in the Customize sheet with your family information. For information about 
customizing the template, see Customizing a template.

Important      This product includes sample forms only. Using them may have significant legal implications; these 
vary from state to state and depend on the subject matter. Use of these forms may not necessarily comply with 
generally accepted accounting principles (GAAP) or other accounting principles or standards. Before using any 
of these forms for your business, you should consult with a lawyer, a financial advisor, and/or an accountant. 
Microsoft and its suppliers are not responsible for any action you take based on the use of this template.

To compare lease options
1    On the Lease Options sheet, fill in the requested information.

2    To see the payment schedules for the lessor's initial offer and the other leasing scenarios, switch to the 
Payment Table sheet. 

3    To compare costs associated with each lease option, switch to the Results Comparison sheet.

For detailed help on creating leasing scenarios, refer to the Cell Notes provided in the template. For information 
about the buttons on the Car Lease toolbar, see Template Toolbar Help.




